# Contents

- **About This Book** .......................................................... v
- **What's New in SAS Model Manager 3.1** ................................ vii
- **Accessibility Features of SAS Model Manager** ......................... ix
- **Recommended Reading** .................................................. xi

**Chapter 1 • Introduction to SAS Model Manager Administrator's Guide** .................................................. 1
   - Overview of SAS Model Manager Administration ..................... 1

**Chapter 2 • Preparing SAS Model Manager for Use** .......................................................... 3
   - Overview of Preparing SAS Model Manager for Use .................. 3
   - Post-Installation Verification and Configuration of SAS Model Manager .......................... 4
   - Creating Operating System Accounts in UNIX Environments .......... 6
   - Enabling the SAS Workspace Server XCMD Option .................... 8
   - Configuring the Dashboard Reports Directory ........................ 8
   - Configuring Report Options ........................................... 9
   - Configuring and Using Java Web Start ................................ 10
   - Configuring the Limitation on the Number of Observations for a Scoring Result Set 11
   - Configuring SAS Workflow for Use with SAS Model Manager ........ 12

**Chapter 3 • Setting Up SAS Management Console for Use** .................................................. 15
   - Overview of Setting Up SAS Management Console for Use with SAS Model Manager .......................... 15
   - Configuring a SAS Model Manager Connection Profile for the SAS Metadata Repository .......................... 16
   - Configuring Users, Groups, and Roles ................................ 20
   - Configuring Alert Notifications for SAS Workflow ................. 31
   - Create Model Manager Libraries in SAS Management Console .......... 32
   - Creating a New Table Using SAS .................................... 35
   - Registering a Table Using SAS Management Console ................ 36
   - Verify Accessibility of Data Tables in SAS Model Manager ........ 39

**Chapter 4 • Creating and Configuring Publication Channels** .................................................. 41
   - Overview of Creating and Configuring Publication Channels ........ 41
   - Define an HTTP or HTTPS Server .................................... 43
   - Define Publish Locations for the SAS Content Server ................ 47
   - Configuring Channels and Subscribers for SAS Model Manager .......... 49
   - Create a Channel Folder ........................................... 50
   - Create a New Channel ............................................. 52
   - Create a New Subscriber ........................................... 55
   - Modify an Existing Channel or Channels Node Location ............... 59

**Chapter 5 • Managing Data Tables, Users, Groups, and Roles in SAS Management Console** ............ 61
   - Overview of Managing Data Tables, Users, Groups, and Roles in SAS Management Console ............ 61
   - Modifying a Data Table ........................................... 61
   - Deleting a Data Table ............................................. 62
   - Managing Users, Groups, and Roles ................................ 63
About This Book

Audience

SAS Model Manager Administration is for the following users:

• Those who are responsible for administering SAS Model Manager.
• Those who are responsible for administering the SAS Metadata Repository for use with SAS Model Manager.

You might be assigned to a specific user group or role. That assignment determines which tasks you can perform. For more information, see “Configuring Users, Groups, and Roles” on page 20.

Prerequisites

Here are the prerequisites for administering SAS Model Manager:

• The following software must be installed on your computer:
  • Java Development Kit v1.6.0_24
  • JBoss Application Server 4.3
  • SAS Management Console 9.3
  • SAS Model Manager Client 3.1
• You must have a user ID and password for logging in to SAS Management Console and SAS Content Server Administration Console.

Conventions Used in This Document

The following typographical conventions are used for all text in this document except for syntax:

bold
  identifies an item in the SAS Model Manager window or a menu item.

italics
  identifies a book title or a value that is supplied by the user.
**monospace**
identifies SAS code.

**UPPERCASE**
identifies a SAS language element, such as the SAS statements KEEP or DROP.

The following typographical conventions are used in syntax:

**bold**
identifies the name of a macro.

**italic**
identifies an argument that must be supplied by the user.

< >
identifies an optional macro argument.

| (vertical bar)
indicates that you can choose one value from a group. Values that are separated by the vertical bar are mutually exclusive.

**UPPERCASE**
indicates a keyword that can be used as a value for an argument.
What's New in SAS Model Manager 3.1

Overview

The SAS Model Manager: Administrator's Guide contains new and updated administrative tasks that are associated with SAS Model Manager.

SAS Model Manager administrative tasks have the following new features and enhancements:

• The SAS Analytics Platform has been deprecated.
• configurations for Java Web Start client.
• configuration of the dashboard reports directory.
• configurations to use SAS Workflow.
• The configurations to prepare a database for use have been moved.
• configurations for report options.

SAS Analytics Platform Has Been Deprecated

The SAS Analytics Platform has been deprecated, and SAS Model Manager now supports deployment to Web application servers that are supported in SAS 9.3. Additional functionality that was previously provided by the SAS Analytics Platform is now provided by the SAS Web Infrastructure Platform.

Configurations for Java Web Start

The Java Web Start client can be used to access the SAS Model Manager 3.1 application using a URL. A default host deployment option is configured during the deployment of SAS Model Manager 3.1 on SAS 9.3. After installation, a SAS administrator can make additional configurations for the Java Web Start client to enable access to the configured SAS environments file.
Configuration of the Dashboard Reports Directory

The SAS Model Manager Dashboard Reports directory is now configured with a default location during installation. If you want to change the location to use a network drive or another location, you can configure the dashboard reports directory using SAS Management Console. Information about how to configure a dashboard reports directory is included in the guide.

Configurations to Use SAS Workflow

The Workflow Console for SAS Model Manager has been added to manage the workflow processes that are associated with modeling projects and versions. The SAS Workflow Studio client application is used to design and deploy workflow process definitions. Configurations are required to use SAS Workflow with SAS Model Manager.

Configurations to Prepare a Database for Use Have Been Moved

When the SAS Model Manager In-Database Scoring Scripts product is part of your SAS 9.3 deployment, post-installation configurations are required. The configuration steps to prepare the database for publishing and scoring in SAS Model Manager have been moved to the SAS In-Database Products: Administrator's Guide.

Configurations for Report Options

The report options can be configured for the model retrain reports and dashboard reports using SAS Management Console.
Accessibility Features of SAS Model Manager

SAS Model Manager 3.1 has been tested with assistive technology tools. It includes accessibility and compatibility features that improve the usability of the product for users with disabilities, with exceptions noted below. These features are related to accessibility standards for electronic information technology that were adopted by the U.S. Government under Section 508 of the U.S. Rehabilitation Act of 1973 (2008 draft proposal initiative update). Applications are also tested against Web Content Accessibility Guidelines (WCAG) 2.0, part of the Web Accessibility Initiative (WAI) of the Worldwide Web Consortium (W3C). For detailed information about the accessibility of this product, send e-mail to accessibility@sas.com or call SAS Technical Support.

For more information about accessibility features and exceptions, see “Accessibility Features of SAS Model Manager” in SAS Model Manager: User's Guide.
Here is the recommended reading list for this title:

- The online Help for the SAS Model Manager.
- *SAS Workflow Studio 1.1: User's Guide*
- *SAS In-Database Products: Administrator's Guide*
- *SAS 9.3 Intelligence Platform: System Administration Guide*
- *SAS Intelligence Platform: Web Application Administration Guide*

For a complete list of SAS publications, go to support.sas.com/bookstore. If you have questions about which titles you need, please contact a SAS Publishing Sales Representative:

SAS Publishing Sales
SAS Campus Drive
Cary, NC 27513-2414
Phone: 1-800-727-3228
Fax: 1-919-677-8166
E-mail: sasbook@sas.com
Web address: support.sas.com/bookstore
Chapter 1
Introduction to SAS Model Manager Administrator's Guide

Overview of SAS Model Manager Administration

The SAS Model Manager: Administrator's Guide explains how to prepare SAS Model Manager for use and how to manage information that is associated with SAS Model Manager. The administrator uses SAS Management Console to access metadata repositories that store information about SAS Model Manager users, libraries, data tables, and the Publishing Framework. Frequently used administrative and configuration tasks are included in this guide to provide guidance after the SAS Model Manager installation process is completed. The high-level tasks include the following:

• Completing post-installation verification and configuration steps for SAS Model Manager
• Preparing a database for use with SAS Model Manager
• Setting up SAS Management Console for use with SAS Model Manager
• Creating and configuring published channels
• Managing data tables, users, groups, and roles
• Configuring directory permissions
Overview of Preparing SAS Model Manager for Use

After installing and configuring SAS Model Manager, you must perform additional tasks to prepare SAS Model Manager for use.

- Verify that all installation and configuration steps have been completed. Perform any required additional configuration steps for the installed SAS solutions.
- If necessary, prepare a database to use with SAS Model Manager.

*Note:* This task needs is required only if you have SAS Scoring Accelerator installed.
For more information about installation and configuration, see the SAS Knowledge Base/Install Center at http://support.sas.com/documentation/installcenter/.

Post-Installation Verification and Configuration of SAS Model Manager

After you install SAS 9.3 and SAS Model Manager 3.1 using SAS Software Depot, you must perform additional configuration steps before you can use SAS Model Manager.

1. Verify that all installation and configuration steps in the instructions.html file have been completed. The instructions.html file is located in \sasconfigdir\Lev#\Documents\.

2. The SAS Deployment Wizard (SDW) does not create SAS Model Manager users by default. The SAS Administrator must create users in SAS Management Console (SMC) with the appropriate group and role permissions. Verify that all users who were created during the installation process to use SAS Model Manager are granted the appropriate permissions to the SAS Workspace Server. In a Windows environment, each user or group must be granted permission to the Log on as a batch job local security policy. In a UNIX environment all SAS Model Manager users must be part of a group that has the appropriate group permissions. For more information, see “Creating Operating System Accounts in UNIX Environments” on page 6 and “Configuring Users, Groups, and Roles” on page 20.

3. If the SAS Workspace Server is located in a UNIX environment, you must enable the SAS Workspace Server XCMD option in order to support R model functionality. For more information, see “Enabling the SAS Workspace Server XCMD Option” on page 8.

4. If the SAS Model Manager In-Database Scoring Scripts product is part of your SAS 9.3 deployment, additional configuration steps are required to prepare the database for publishing and scoring in SAS Model Manager. For more information, see “Preparing a Database for Use with SAS Model Manager” in Chapter 7 of SAS In-Database Products: Administrator’s Guide.

5. Configure SAS Workflow. For more information, see “Configuring SAS Workflow for Use with SAS Model Manager” on page 12.

6. To perform tasks such as performance monitoring and model retrain, you must modify the contents of the -JREOPTIONS parameter by using the sasv9_usermods.cfg file. There are multiple versions of this file. Modify the file that is located in the \sasconfigdir\Lev#\SASApp\WorkspaceServer\ directory.

The following lines of code and user-supplied values must be added to the file:

```
-JREOPTIONS=(
-Djgroups.bind_addr=[IP Address]
-Djava.net.preferIPv4Stack=true
-Djava.net.preferIPv6Addresses=false
)
```

If you do not know the correct value for the JGroups bind address, you can find the value on the server where SAS Remote Services is installed. To retrieve the IP address, use the ipconfig command for Windows and use the ifconfig command for UNIX. The parameters for the ifconfig command can vary
depending on the UNIX platform that is being used. For more information about these commands and their parameters, see your platform documentation. If you use IPv4 network addresses, the true and false values above are valid. If you use the IPv6 network address, you must reverse the true and false values. That is preferIPv4Stack=false and preferIPv6Addresses=true.

Note: In certain circumstances, such as machines with multiple network adapters or protocols, you might need to perform additional configurations for the JGroups bind address. For more information, see “Configuring the JGroups Bind Address” in Chapter 13 of SAS Intelligence Platform: Middle-Tier Administration Guide.

7. Verify the configuration of the dashboard reports directory on the SAS Workspace Server. For more information, see “Configuring the Dashboard Reports Directory” on page 8.

8. If you have installed SAS Model Manager to use with SAS Enterprise Miner, you must access the SAS Content Server and create a public directory for SAS Enterprise Miner to register a model SAS package (SPK) file. To create a SAS Content Server public directory, follow these steps:

   a. Access the SAS Content Server Administration Console by entering http://hostname:port/SASContentServer/dircontents.jsp. An example of hostname:port is localhost:8080. Log in using the SAS Administrator account (for example, sasadm@saspw) that you defined during the SAS installation process.

   b. In the Add folder field, enter a folder name such as Models.

   c. Click Add folder.

   d. The Models folder is displayed in the Item name column.

   e. Click the Permissions icon that is associated with the Models folder.

   f. In the Add principal field, enter the value jcr:all. Change all of the permissions to Yes.

   g. Click Save Changes.

   h. Log off from the SAS Content Server Administration Console and restart any open SAS Enterprise Miner sessions to pick up the changes.

9. If you have installed SAS Model Manager to use with SAS Enterprise Miner, you must configure the SAS Metadata Repository to use the SAS Content Server public directory that you created previously. Follow these steps:

   a. In SAS Management Console, expand Application Management on the Plugins tab. SAS Enterprise Miner should be listed and should contain subfolders.

   b. Expand the Projects folder.

   c. Right-click the SAS Workspace Server that is associated with your SAS Enterprise Miner installation, and select Properties. An example is SASApp - Logical Workspace Server.

   d. Click on the Options tab.

   e. In the WebDAV URL field, enter http://hostname:port/SASContentServer/repository/default/Models/.

   Note: WebDAV is used to register a model SPK file from SAS Enterprise Miner.
f. Click **OK** and then restart any open SAS Enterprise Miner sessions to pick up the changes.

For more information about post-installation tasks, see the SAS 9.3 installation documentation.

---

**Creating Operating System Accounts in UNIX Environments**

### Using Operating System Groups to Assign Permissions

Users have different operating system privileges on the SAS Workspace Server. By defining a user group for SAS Model Manager, you can assign all SAS Model Manager users to the same group and grant the same permissions to all SAS Model Manager users at one time. All SAS Model Manager users must have Read, Write, and Execute permissions for each environment directory that a user is permitted to use. Users also need permissions to all of the files and directories in an environment directory. The operating system must be configured to grant these permissions as new files and directories are created. The steps that you follow to do this depend on which operating system groups are defined and your site’s security policies.

### Conditions for the User Group for SAS Model Manager

If you are working in a UNIX operating environment, the following conditions must be met:

- A group of users is created for the UNIX operating environment. The logon IDs for each SAS Model Manager user must be in this group. The group must also include any user who might run code that is created from a SAS Model Manager project in a SAS session.
- Users can be members of multiple groups, but the SAS Model Manager group is the primary group for each user.
- The SAS scripts are updated to grant permissions to the SAS Model Manager users on the SAS Workspace Server. For more information, see “Update the SAS Scripts to Grant Permissions to the User Group” on page 6.
- Each environment directory has the correct ownership, and the user group for the SAS Model Manager has Read, Write, and Execute permissions.

### Update the SAS Scripts to Grant Permissions to the User Group

Using the `umask` option, you can grant permissions to the SAS Model Manager users on a conditional basis if the user is part of the SAS Model Manager user group.

**Note:** This example might require changes to fit your server configuration. In particular, this example could result in changed permissions on other SAS files, such as OLAP cubes. For example, if you are working with multiple UNIX groups and have a SAS OLAP Server, you must ensure that the account under which the SAS OLAP Server runs keeps the Read and Execute permissions to OLAP files.
To set these permissions:


2. Enter the configuration information for your operating environment. Here is the general format of this code:

   **Note:** The following code uses grave accents and not quotation marks.

   ```
   CMD=<your-operating-system-path>
   CURR_GID=`eval $CMD -g`
   GID=<solution-group-id>
   if [ $CURR_GID -eq $GID ]; then umask 002 fi
   ```

   a. In the `CMD=<your-operating-system-path>`, specify the full path on your server where the ID command is stored. You can get this information by typing a `which id` or `whence id` command on your console.

   b. In the `GID=<solution-group-id>`, specify the group ID. Type `id` on your console to get the GID and UID information.

   c. A value of 002 is recommended for the `umask` option.

   Here are code examples for each UNIX environment where SAS Model Manager is supported:

<table>
<thead>
<tr>
<th>Operating Environment</th>
<th>Sample Code</th>
</tr>
</thead>
</table>
   | AIX                   | CMD=/usr/bin/id  
                         CURR_GID=`eval $CMD -g`  
                         GID=201  
                         if [ $CURR_GID -eq $GID ]; then umask 002 fi |
   | H64I (HP-Itanium)     | CMD=/usr/bin/id  
                         CURR_GID=`eval $CMD -g`  
                         GID=201 if [ $CURR_GID -eq $GID ]; then umask 002 fi |
   | S64 (Solaris)         | CMD=/usr/xpg4/bin/id  
                         CURR_GID=`eval $CMD -g`  
                         GID=201 if [ $CURR_GID -eq $GID ]; then umask 002 fi |
   | SAX (Solaris for X64) | CMD=/usr/xpg4/bin/id  
                         CURR_GID=`eval $CMD -g`  
                         GID=201 if [ $CURR_GID -eq $GID ]; then umask 002 fi |
   | LNX (Linux)           | #!/bin/bash  
                         CMD=/usr/bin/id  
                         CURR_GID=`eval $CMD -g`  
                         GID=500  
                         if [ "$CURR_GID" -eq "$GID" ]; then umask 002 fi |
Enabling the SAS Workspace Server XCMD Option

When you are running the SAS Workspace Server in a UNIX environment for a SAS Model Manager 3.1 on SAS 9.3 deployment, the XCMD option is turned off by default. So you cannot use the SYSTEM function, the X command, or the PIPE option in a FILENAME statement. You must enable the SAS Workspace Server XCMD option in order to support R model functionality.

To enable the XCMD option, follow these steps:

1. From SAS Management Console, expand the Server Manager node on the Plug-ins tab.
4. Select Options -> Advanced Options -> Launch Properties and then select the Allow XCMD check box.
5. Click OK to save the setting.
6. Stop and restart your SAS Object Spawner.

Configuring the Dashboard Reports Directory

In SAS Model Manager 3.1, the dashboard report directory is configured during installation. The default directory is \SASConfigDir\Lev\#\AppData\SASModelManager3.1\Dashboard.

Note: When the Application Server and the SAS Workspace Server are located on different physical machines the Software Deployment Wizard (SDW) creates a directory on the Application Server machine and uses that value for the App.DashboardDir property value. You must create a directory that is accessible by the SAS Workspace server, and the SAS Model Manager users must have permissions to the directory.

To configure a different directory to store the SAS Model Manager dashboard reports, follow these steps:

1. Connect to the SAS Workspace Server.
2. Create a new directory (for example, C:\Dashboard).

Note: The directory must be located on a SAS Workspace Server or a network drive that is accessible by the SAS Workspace Server. Do not include special characters or spaces in the name of the directory.

3. Grant user permissions for the new directory. For example, perform the following tasks:
   • Grant Full Control permission to users who need to create subdirectories, write content, or delete content. This type of user includes a user who you will be
adding (using SAS Management Console) to the Model Manager Administrator Users group or a user who is a SAS Administrator.

- Grant Read, Write, and Execute permissions to users who need to create performance indicators and execute dashboard reports. This type of user includes a user who you will be adding (using SAS Management Console) to the Model Manager Advanced Users group.

- Grant Read and Execute permissions to users who need only to view the dashboard reports. This type of user includes a user who you will add (using SAS Management Console) to the Model Manager Users group.

Note: In a UNIX environment all SAS Model Manager users must be part of a group that has the appropriate group permissions. For more information, see “Creating Operating System Accounts in UNIX Environments” on page 6 and “Configuring Users, Groups, and Roles” on page 20.

4. From SAS Management Console, expand the Application Management node on the Plug-ins tab.

5. Select and expand Configuration Manager ⇒ SAS Application Infrastructure.

6. Right-click Model Manager JavaSvcs 3.1 and select Properties.

7. (optional) Click the Settings tab and then select Report Options. Use this setting to specify the styles that are available when a user generates dashboard reports, and to enable the indicator override option for defining dashboard report indicators. When you use the indicator override configuration, indicators with conditions are available when you add dashboard report indicators using the SAS Model Manager Client. For more information, see “Configuring Report Options” on page 9.

8. Click the Advanced tab to modify the application dashboard directory. Change the property value for App.DashboardDir to the directory path that was configured.

9. Click OK.

---

### Configuring Report Options

The **Report Options** setting in SAS Management Console enables you to modify the SAS Model Manager configurations for the model retrain reports and dashboard reports. These reports are available when you use the SAS Model Manager client.

To modify the report options setting, follow these steps:

1. Log on to SAS Management Console as a SAS administrator.

2. On the Plug-ins tab, navigate to Application Management ⇒ Configuration Manager ⇒ SAS Application Infrastructure.

3. Right-click Model Manager JavaSvcs 3.1 and select Properties.

4. Click the Settings tab and then select Report Options.
5. (Optional) Specify the formats that are available when a user creates model retrain reports. The default values are RTF, PDF, HTML, and EXCEL. You can remove any of the default values so that they are not available in the SAS Model Manager client.

6. (Optional) Specify the report styles that are available when a user creates the model retrain reports and dashboard reports. You can add or remove SAS styles. The default values are Seaside, Meadow, Harvest, and Default. For more information about SAS styles, see “Understanding Styles, Style Elements, and Style Attributes” in Chapter 3 of *SAS Output Delivery System: User's Guide*.

7. (Optional) Select Yes for the dashboard indicator override. When you do that, indicators with conditions are available when a user adds dashboard report indicators.

8. Click OK.

---

**Configuring and Using Java Web Start**

For a SAS Model Manager 3.1 on SAS 9.3 deployment, the Java Web Start client can be used to access the SAS Model Manager 3.1 application by entering the URL `http://hostname:port/SASModelManagerJWS/Status` in your Web browser. The default value for the SAS Environments URL on the Status page is *(undefined)*. When you click Launch, the default value for the SAS environment field is *(host deployment)*, unless you configure the Java Web Start Client to use the SAS environment URL in SAS Management Console.
Note: Only a SAS administrator (for example, sasadm@saspw) can configure the Java Web Start client for SAS Model Manager.

To specify the link to the Java Web Start client as the SAS environment URL, follow these steps:

1. From SAS Management Console, expand the Application Management node on the Plug-ins tab.

2. Select and expand Configuration Manager ⇒ SAS Application Infrastructure.

3. Right-click Model Manager JWS 3.1 and select Properties.

4. Click the Settings tab, and then select Model Manager Java Web Start Options.
   - Enter a value is for the SAS environment URL setting, and in the format of http://hostname:port/SASLogon/sas-environment.xml. For more information about SAS environments, see Appendix 1, “Configuring the SAS Environment File,” in SAS Intelligence Platform: Middle-Tier Administration Guide.
   - Verify that the value that is specified for the Preferred SAS environment setting is the SAS environment that should be selected by default in the client’s logon dialog box. If a valid SAS environment with the specified name is not found, the value is ignored.

5. Make any necessary changes to the settings, and click OK.

6. To verify that Java Web Start has been configured correctly, enter the URL http://hostname:port/SASModelManagerJWS/Status in your Web browser, verify that there is a value for the SAS Environments URL property, and then click Launch.

---

Configuring the Limitation on the Number of Observations for a Scoring Result Set

When the Scoring Task Type property is set to Production in SAS Model Manager, you can use SAS Management Console to limit the number of observations that a scoring result set can contain.

To configure a limitation for the number of observations, follow these steps:

1. From SAS Management Console, expand the Application Management node on the Plug-ins tab.

2. Select and expand Configuration Manager ⇒ SAS Application Infrastructure.

3. Right-click Model Manager JavaSvcs 3.1 and select Properties.

4. Click the Advanced tab. Change the property value for App.TableObsLimitation to limit the number of observations in the scoring result set. The default value of 0 indicates that there is no limit to the number of observations that a scoring result set can contain.

5. Click OK. The value that you specified now appears in the Number of Observations result set property when you create a scoring task using SAS Model Manager.
Configuring SAS Workflow for Use with SAS Model Manager

Overview

SAS Workflow provides services that work together to model, automate, integrate, and streamline business processes. It provides a platform for more efficient and productive business solutions.

SAS Workflow is used by SAS solutions that benefit from business process management. SAS Workflow Studio is a desktop client application that is used to design and deploy workflow process definitions. The SAS middle tier hosts the workflow engine and the workflow services as part of the SAS Web Infrastructure Platform. The Workflow Console for SAS Model Manager is used to manage the workflow processes that are associated with modeling projects and versions. For more information about SAS Workflow, see “SAS Workflow” in Chapter 1 of SAS Intelligence Platform: Middle-Tier Administration Guide.

To use SAS Workflow with SAS Model Manager, be sure the following prerequisites are met:

1. SAS Workflow Engine, SAS Workflow Services, and SAS Workflow Studio must be installed and configured. For more information, see SAS Intelligence Platform: Installation and Configuration Guide
2. If you want to receive notifications for a workflow process, you can configure alert notifications using SAS Management Console. For more information, see “Configuring Alert Notifications for SAS Workflow” on page 31.
3. Workflow process definitions must be created using SAS Workflow Studio. For more information about creating process definitions, see the SAS Workflow Studio 1.1: User’s Guide.

Guidelines for Creating Process Definitions

When you create process definitions in SAS Workflow Studio to use with SAS Model Manager, follow these guidelines:

• Statuses, participants, and policies must be added to the activity level. The default statuses at the process definition level cannot be used with SAS Model Manager. Data objects can be added at the process definition level or activity level.

• Only the Potential Owner, Actual Owner, and Business Administrator workflow roles are used by SAS Model Manager and they can be used in either a participant or swimlane definition.

• In order to assign additional participants to activities using the Workflow Console, the user must have or be in a group that is assigned the workflow role of business administrator. Also, in order to create new instances and assign participants, the user must be in the Model Manager Administrator Users group or in a group that is associated with the Model Manager Administrator Users group in SAS Management Console. The following SAS Model Manager groups are created at installation time:

  • Model Manager Administrator Users Group (mdlmgradminusers)
For more information, see “Configuring Users, Groups, and Roles” on page 20.

Only process definitions that are in the Workflow repository, with the mmapi tag attribute specified in the file properties, are available to SAS Model Manager in the Workflow Console.

How to Make Process Definitions Available to SAS Model Manager

After you have created a process definition in the SAS Workflow Studio, you must make the process definition available to SAS Model Manager.

To save the process definition to the Workflow repository, follow these steps:

1. Save the process definition to your local drive.
2. Log on to the server.
3. Add the tag attribute of mmapi to the process definition file properties.
4. Upload the process definition.
5. Verify that the process definition appears in the Process Definitions category view of SAS Model Manager Workflow Console.

For more information, see “Deploying and Maintaining Processes” in the SAS Workflow Studio 1.1: User’s Guide.

Log On to the Server

With SAS Workflow Studio, you are limited to managing locally stored workflow process definitions on your system until you have logged on to the SAS Content Server. After you are connected, you can access additional process definitions that are stored in the SAS Content Server.

To log on to the server, follow these steps:

1. From the Server menu, select Logon.
2. In the Log On window, select the host-name from the SAS environment drop-down list.
   
   Note: For more information, see Appendix 1, “Configuring the SAS Environment File,” in SAS Intelligence Platform: Middle-Tier Administration Guide.
3. Enter a user ID and password, and click Log On.

Add Tag Attributes to a Process Definition

Only those process definitions in the Workflow repository that have the mmapi tag attribute specified in the file properties are available to SAS Model Manager in the Workflow Console.

To add a tag attribute to the file properties of a process definition template in SAS Workflow Studio, follow these steps:

1. Select File ➜ Properties and click Add.
2. Enter the tag value of mmapi.
Note: The file properties are case sensitive. This value must be lowercase.

3. Click OK twice.

Upload a Process Definition

To upload a process, follow these steps:

1. From the Server menu, select the Save to Repository menu option. The Save to Workflow Repository window appears.

2. (Optional) Enter relevant comments to associate with the process definition.

3. Select the Activate option if you want to activate the current version in the Workflow repository.

4. Click OK.

Verify That the Process Definitions Are Available in the Workflow Console

To verify that the workflow process definitions are available in the Workflow Console, follow these steps:

1. Enter the URL \texttt{http://hostname:port/SASModelManagerWorkflow} in your Web browser.

2. Enter the user ID and password for a SAS Model Manager administrator.

3. Verify that the uploaded process definition appears in the Process Definitions category view.

See Also

Chapter 3
Setting Up SAS Management Console for Use

Overview of Setting Up SAS Management Console for Use with SAS Model Manager

SAS Management Console acts as the user interface to the SAS Metadata Repository. In order for SAS Model Manager to read data tables, the metadata for those tables must also exist within the SAS Metadata Repository. The metadata for the data tables is stored in libraries within the SAS Metadata Repository. SAS Management Console also enables administrators to configure users, groups, roles and to create publication channels.

You can determine how you want to organize your SAS libraries. For example, you can put all of the tables that are needed by a given project, version, model, scoring task, and report in one library. Or, you can create seven libraries that correspond to the structure of the Data Sources folders that SAS Model Manager uses. In most cases, users already...
have model tables grouped in project-related SAS libraries. Most of the time, your SAS Model Manager Data Sources folders contain tables from different SAS libraries.

Configuring a SAS Model Manager Connection Profile for the SAS Metadata Repository

Overview of Configuring a Connection Profile

A connection profile enables you to communicate with the SAS Metadata Repository from SAS Management Console. Before you can define SAS Model Manager libraries, users, groups, roles, and publication channels in SAS Management Console, you must create a connection profile.

The Connection Profile wizard guides you through the process of creating the profile for your server. For more information, see the Help.

Create a New Metadata Profile

To create a new metadata profile, follow these steps:

1. Start SAS Management Console. The Connection Profile dialog box appears.

2. Select Create a new connection profile, and click OK. The Connection Profile wizard window appears.
3. Click Next.

4. Enter the name of your connection profile. Select the check box if you want to open this connection profile by default. Click Next.
5. Complete the following connection information:

a. Enter the fully qualified name (or IP address) of the machine on which your metadata server operates. Enter the TCP/IP port number that was defined at installation. By default the port is 8561.

b. Enter a valid user ID and a password.

c. (Optional) Select the check box to save the user ID and password for this profile. 
   
   *Note:* When you select this option, the user ID and password are saved and automatically displayed when this profile is chosen during login.

d. Click **Next**. A summary of the connection profile options that you defined is displayed.
6. Click **Finish** to save your connection profile.

   SAS Management Console is then connected to your active connection profile server as shown on the window title bar.

   **Note:** You need to verify that Publishing Framework plug-ins are available on your SAS Management Console navigation tree. Otherwise, you need to install SAS Foundation Services 1.3 or higher so that you can configure your channels and subscribers for SAS Model Manager.

---

**Connect to an Existing Metadata Profile**

To connect to or change your SAS Metadata Server connection profile, follow these steps:

1. Select **File ➔ Connection Profile**. The Disconnect from Server dialog box appears.

2. Click **Yes**. The Connection Profile dialog box appears.
3. Select **Open an existing connection profile**.

4. Select the name of your SAS Metadata Server connection profile from the list.

5. Click **OK**.

Now you should see your SAS Metadata Server name in the SAS Management Console status bar (*server-name:*port number).

---

**Configuring Users, Groups, and Roles**

**Overview of Configuring Users, Groups, and Roles**

When you use SAS Management Console to configure users, groups, and roles, users from different departments or divisions can collaborate to create, update, and deploy models. They use the SAS Publishing Framework to inform subscribers about model updates.

As an administrator, you need to create users, user groups, and then assign roles in order for users to access the SAS Model Manager repository. The **User Manager** plug-in for SAS Management Console allows a user to define a user or a group. A wizard helps you create the user and groups of users and also to assign roles.

*Note:* If you are using an automated approach to add and maintain user identities, see **SAS Note 40628** or the Appendix 1, “User Import Macros,” in *SAS Intelligence Platform: Security Administration Guide*.

**SAS Model Manager Users, Groups, and Roles**

The following users, groups, and roles are created as part of the SAS Model Manager installation process:

*Note:* The SAS Model Manager Administrator user is no longer created by default during installation. You must create a user and assign the user to the **Model Manager Administrator Users** group.
### Table 3.1  SAS Model Manager Users

<table>
<thead>
<tr>
<th>User</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Administrator</td>
<td>This user has access to all SAS Management Console capabilities and metadata administrative tasks. SAS 9.3 creates this user during installation.</td>
</tr>
<tr>
<td>SAS Demo User</td>
<td>This user is optional. You can choose to create this user during installation. However, this user is not assigned to a group during installation.</td>
</tr>
</tbody>
</table>

### Table 3.2  SAS Model Manager Groups

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Administrators</td>
<td>This group performs metadata administrative tasks. SAS 9.3 creates this group during installation.</td>
</tr>
<tr>
<td>Model Manager Administrator Users</td>
<td>This group has administrative permissions for the SAS Model Manager Client and to the Workflow Console.</td>
</tr>
<tr>
<td>Model Manager Advanced Users</td>
<td>This group has permissions to read, write, and delete content.</td>
</tr>
<tr>
<td>Model Manager Users</td>
<td>This group has permission to read content.</td>
</tr>
<tr>
<td>Model Manager Example Life Cycle Assignee Users</td>
<td>This group is used by the example life cycle templates that are shipped with SAS Model Manager. The group contains those users who can change the status of life cycle tasks, but who cannot approve them.</td>
</tr>
<tr>
<td>Model Manager Example Life Cycle Approver User</td>
<td>This group is used by the example life cycles templates that are shipped with SAS Model Manager. The group contains those users who can approve completed life cycle tasks.</td>
</tr>
</tbody>
</table>

### Table 3.3  SAS Model Manager Roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment Administrator</td>
<td>A user who can manage comments in the SAS Model Manager Workflow Console. This role is assigned to the group Model Manager Administrators.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Console: Advanced</td>
<td>Provides access to all plug-ins in SAS Management Console. This role is assigned to the group SAS Administrators.</td>
</tr>
<tr>
<td>Metadata Server: Operation</td>
<td>Supports adding metadata repositories and operating the metadata server. This role is assigned to the group SAS Administrators.</td>
</tr>
<tr>
<td>Metadata Server: User Administration</td>
<td>Supports management of users, groups, and roles other than the unrestricted users role. This role is assigned to the group SAS Administrators.</td>
</tr>
<tr>
<td>Metadata Server: Unrestricted</td>
<td>Provides all capabilities in SAS Management Console and provides access to all metadata. This role is assigned to the group SAS Administrator Users.</td>
</tr>
<tr>
<td>Model Manager: Administration Usage</td>
<td>A user who can perform all SAS Model Manager tasks. This role is assigned to the group Model Manager Administrator Users.</td>
</tr>
<tr>
<td>Model Manager: Advanced Usage</td>
<td>A user who can perform all SAS Model Manager tasks except for tasks that can be performed only by a SAS Model Manager administrator. This role is assigned to the group Model Manager Advanced Users.</td>
</tr>
<tr>
<td>Model Manager: Usage</td>
<td>A SAS Model Manager general user. The general user can perform all tasks except for advanced user tasks and administrator tasks. This role is assigned to the group Model Manager Users.</td>
</tr>
<tr>
<td>Model Manager: Life Cycle Assignee Usage</td>
<td>A user or group who can be assigned to complete a life cycle task.</td>
</tr>
<tr>
<td>Model Manager: Life Cycle Approval Usage</td>
<td>A user or group who can approve the completion of a life cycle task.</td>
</tr>
<tr>
<td>Model Manager: Life Cycle Participant Usage</td>
<td>A user or group that is displayed in the Participant selection list of the Life Cycle Template Editor.</td>
</tr>
</tbody>
</table>

For more information about SAS Model Manager tasks that are associated with each role, see the *SAS Model Manager: User's Guide*.  


Create a New User

Before creating users for SAS Model Manager, you need to define these users on your network domains with valid user IDs and passwords. SAS Management Console helps you create users by using the New User wizard. You can click Help any time to get information about the current window properties.

To create a new user, follow these steps:


2. Enter the name of the user on the General tab.
   The Display Name, Job Title, and Description are optional.
   **CAUTION:**
   Do not use spaces or special characters in the name of a user, group or role.

3. Provide an e-mail address for the user to receive e-mail notifications from the SAS Publishing Framework. Click the Email tab on the lower panel and then click New. The Email Properties dialog box appears.
4. Enter SMTP in the **Type** field and the user's e-mail address in the **Address** field. Click **OK**.

5. Click the **Group and Roles** tab if you want this user to be included in a specified group. Use the arrow ▶ to add the new user to a group.

6. Click the **Accounts** tab and select **New**. The New Login Properties dialog box appears.
7. Enter the User ID, Password, and the Authentication Domain. Click New to create a new valid domain. Enter a name and description for the new domain, and then click OK twice to add the new account.

8. (Optional) Click the Authorization tab if you want to add users or groups that can view and modify the metadata of this group. It is recommended that you specify authorizations for group level and not user level.

9. Click OK.

The newly created user is displayed with all the other users when the User Manager object is selected from the SAS Management Console navigation tree.

10. In a Windows environment grant the new user permissions for the user rights assignment of Log on as a batch job for local security policies on the machine that hosts the SAS Workspace Server.

**Create a New User Group**

To create a user group, follow these steps:

2. Enter the name of the group on the **General** tab. The other fields are optional.

3. Click the **Members** tab. From the **Available Identities** list, select the users to be included in this group. Select the user name from the **Available Identities** list and click to add it to the **Current Members** list.
4. (Optional) Select the **Groups and Roles** tab if you want this user group to be included in a specified group.

5. (Optional) Select the **Accounts** tab. You might need this to create the New Login Properties for users who were not defined previously.

6. (Optional) Click the **Authorization** tab if you want to add users or groups that can view and modify the metadata of this group.

7. Click **OK**.

   The newly created group name is displayed with all the other groups when the User Manager object is selected from the SAS Management Console navigation tree.

---

**Create a New Role**

To create a new role, follow these steps:

1. Right-click **User Manager** from the SAS Management Console **Plug-ins** tab, and select **New → Role**. The New Role Properties window appears.
2. Enter the name of the role on the \textbf{General} tab. The other fields are optional.

3. Click the \textbf{Members} tab. From the \textbf{Available Identities} list, select the users and groups to assign to this role. Select the user or group name from the \textbf{Available Identities} list and click $\rightarrow$ to add it to the \textbf{Current Members} list.
4. Click the **Capabilities** tab. Expand the tree nodes, and then select the check boxes to assign capabilities to the role.
5. Click the **Contributing Roles** tab to give this role all of the capabilities of one or more other roles. Use the arrows to add the new user to a group.

*Note:* Changes that you make to a role's capabilities affect any roles with which that role is associated.
6. (Optional) Click the **Authorization** tab if you want to add users or groups that can view and modify the metadata of this role.

7. Click **OK**.

The newly created role name is displayed with all the other roles when the **User Manager** object is selected from the SAS Management Console navigation tree.

---

### Configuring Alert Notifications for SAS Workflow

To enable workflow participants to receive alert notifications from SAS Workflow you must configure the **E-mail** notification type in SAS Management Console. After you have configured the alert notifications, you can then use the Notify Participant policy and other workflow notification policies for workflow process activities in SAS Workflow Studio. The notifications setting in SAS Management Console is a global setting. Preferences and notifications can also be configured for individual users.

The Send Notification By Data Object policy in SAS Workflow Studio integrates with the SAS Web Infrastructure Platform’s Notification Service. Recipients are notified according to their preferences (e-mail or portlets).

1. Log on to SAS Management Console as an administrator.

2. On the **Plug-ins** tab, navigate to **Application Management** ➔ **Configuration Manager** ➔ **SAS Application Infrastructure**.

3. Right-click **SAS Application Infrastructure** and select **Properties**.
4. Click the **Settings** tab.
5. Select **Notifications** in the left panel. Use the menus or text fields to set the property.
6. Select the **E-mail** notification type.
7. Click **OK**.
8. To apply this setting and make it available, restart the SAS Web Infrastructure Platform Services, SAS Shared Services, and applications using SAS Workflow.

For more information about the notification properties, see “Setting Global Properties for SAS Applications Using SAS Application Infrastructure Properties” in Chapter 5 of *SAS Intelligence Platform: Middle-Tier Administration Guide*. For more information about setting the notification policies for SAS Workflow, see the SAS Workflow Studio Help or *SAS Workflow Studio: User’s Guide*.

---

**Create Model Manager Libraries in SAS Management Console**

To create a new SAS library in SAS Management Console, follow these steps:

1. Start SAS Management Console and connect to your preferred SAS Metadata Repository.
2. In the SAS Management Console tree, expand the following folders:
   - **Environment Management** ➔ **Data Library Manager** ➔ **Libraries**.
3. Right-click the **Libraries** folder. From the pop-up menu, select **New Library**. The New Library Wizard opens.
4. In the folder display, ensure that the folders are expanded for Resource Templates ⇒ Libraries ⇒ SAS Data. Select SAS BASE Library and then click Next.

5. Enter a name, description, and location for your new SAS library, and then click Next. Add an optional description.

6. (Optional) Select the SAS server where the new library is to be assigned, and then click Next.
7. Enter a unique SAS library reference name of eight characters or fewer. You will use the SAS libref to access the table.

8. Use the arrow controls to choose a path from the Path Specification Available items box, or click New to specify a new path for your library. Afterwards your library path specification appears in the Path Specification Selected Items list. Click Next.
9. Review the summary of the information that you entered, and if it is correct, click 
   Finish.

Your SAS Library appears in the SAS Management Console SAS Libraries list. It has 
been added to the SAS Metadata Repository. Now you can view your new SAS library 
in SAS Model Manager. For more information, see “Verify Accessibility of Data Tables 
in SAS Model Manager” on page 39.

---

Creating a New Table Using SAS

Here are two examples of how to create a new table by submitting SAS code. The first 
example creates a table based on another existing table. The second example shows how 
to create a new empty table.

If you submit the example code below to SAS, make sure that the directory path that is 
specified in the LIBNAME statement exists. Before you submit the code in Example 1, 
you need to verify that the appdata.sas7bdat file exists in the specified LIBNAME 
directory. After the code from the examples is submitted to SAS, two new .sas7bdat files 
will be created on disk at the location c:\smmwork.

**Example Code 3.1  Create a New Table from an Existing Table**

```sas
LIBNAME smmwork 'c:\smmwork';
data smmwork.PROJECTIN;
set smmwork.appdata;
keep age numCards everDefault;
if _N_>1 then stop;
run;
```
Example Code 3.2  Create a New Empty Table

LIBNAME smmwork 'c:\smmwork';
data smmwork.PROJECTOUT;
length posterior 8 prediction $1;
posterior=.; prediction='';
run;

Registering a Table Using SAS Management Console

Overview of Registering a Table

After you create your data tables, you must register them in a SAS Metadata Repository so that the SAS Model Manager can locate them. SAS Model Manager can add data tables from the SAS Metadata Repository that are registered in SAS Management Console. You register tables in SAS Management Console in the Data Library Manager, Libraries folder.

How to Register a Table

The Register Tables wizard guides you through the process of importing and registering a SAS table in the SAS Metadata Repository. Each library type has a different Register Tables wizard that is called from the Data Library Manager.

Note: The Register Tables wizard is not available on UNIX platforms.

To import and register a table into a SAS Management Console Data Library, follow these steps:

1. Copy the .sas7bdat file for your table into the directory path on the Workspace server that you provided in the Path Specification data field of the New Library Wizard. For more information, see “Create Model Manager Libraries in SAS Management Console” on page 32.

2. Start SAS Management Console, and connect to the SAS Metadata Repository that contains your new SAS Library.

3. In the SAS Management Console tree, expand the following folders:

   Environment Management ⇒ Data Library Manager ⇒ Libraries

4. Right-click the SAS Library name that you want to import your table into, and then select Register Tables from the pop-up menu. The Register Tables wizard window appears.
5. Verify that the information that is displayed in the **Select a SAS Library** page is correct, and then click **Next**.

6. The Default Application Server dialog box might appear if the selected folder location is **User Folders** or if a default application server has not been previously selected. Select your SAS server, click **Test Connection** to verify that the connection to the server is successful, and then click **OK**.

7. If prompted, enter your SAS user ID and password to log on to your SAS server.

8. The **Define Tables and Select Folder Location** page is displayed. Select the table or tables that you want to register, and then click **Next**.
9. Click Finish.

The metadata for the imported table is written into the SAS Metadata Repository and is associated with the selected SAS Library.
Note: You must create folders with appropriate access permissions so that users can manage their models, create reports, and publish model updates. If a SAS Model Manager user does not have the appropriate permissions to access a folder, then the tables and libraries are not listed in the Data Sources perspective of SAS Model Manager. For more information about creating a folder and setting permissions, see the SAS Management Console Help.

See Also

“Create Model Manager Libraries in SAS Management Console” on page 32

Verify Accessibility of Data Tables in SAS Model Manager

To verify that your new library and associated tables are accessible in SAS Model Manager, follow these steps:

1. Start SAS Model Manager and select the Data Sources perspective.
2. Expand the SAS Folders node and navigate to the location of the folder that you selected to store your registered tables, when creating your new library.
3. Expand the folder and verify that the metadata tables that are associated with your new SAS library are displayed.
4. Select a metadata table to view the associated columns and data in the Details pane.
For more information about data sources in SAS Model Manager, see the *SAS Model Manager: User's Guide*. 
Overview of Creating and Configuring Publication Channels

SAS Model Manager uses the SAS Publishing Framework to publish model updates to an operational environment for testing and production. The SAS Administrator creates and configures definitions for channels, content subscribers, and group subscribers. Then the user can use the SAS Model Manager model extraction macros or user-written SAS code to retrieve and deploy the updated models to the operational environment.

As shown in the following figure, several tasks are necessary to configure and use the SAS Model Manager publishing functionality.
Here are the tasks.

1. The SAS Model Manager administrator creates either an archive or a WebDAV persistent storage location for channels that is accessible from the SAS Workspace Server.

2. The SAS Model Manager administrator creates SAS Model Manager users, HTTP servers, content subscribers, and channels using SAS Management Console.

3. The SAS Model Manager administrator or an advanced user publishes models using the SAS Model Manager Client.

4. The content subscriber (for example, Scoring personnel) receives an e-mail notification from the SAS Model Manager Server that contains a channel content update.

5. The content subscriber extracts models from a channel (for example, on a SAS Content Server) to prepare them for scoring.

*Note:* SAS Management Console Help provides details for your SAS Model Manager publishing configuration options.

It is recommended that at first you use channels that have the Archive File type for the persistent storage option. This is the simplest channel definition and configuration to use.
Define an HTTP or HTTPS Server

The SAS Model Manager installation process defines a default SAS Content Server. Use this process to add HTTP or HTTPS servers. A WebDAV-enabled HTTP or HTTPS content server must be defined in SAS Management Console before you can publish to channels from SAS Model Manager. The server is usually a third-party server such as Microsoft Internet Information server or an Apache server.

Note: You must have WriteMetadata permission for a repository in order to define an HTTP or HTTPS content server for that repository.

To define your HTTP or HTTPS content server, follow these steps:

1. Start SAS Management Console. Open your existing connection profile for your server. If your connection profile is not available in the list, see “Configuring a SAS Model Manager Connection Profile for the SAS Metadata Repository” on page 16.

2. From the Plug-ins tab, right-click Server Manager, and then select New Server. The New Server Wizard window appears.

3. Select Resource Templates ⇒ Servers ⇒ Content Servers ⇒ Http Server, and then click Next.
Note: If the HTTP server template is not available, then you must add the resource template. For more information, see the SAS Management Console Help.

4. Enter the name and the description of your HTTP server. Click Next.
5. (Optional) On the server properties page, enter the software version and vendor information for the third-party HTTP or HTTPS server that you are defining.

6. Click New to create base path or paths on your server. The New Base Path dialog box appears.

   Note: If you have not defined the base path for your HTTP server, see “Define Publish Locations for the SAS Content Server” on page 47.

7. In the Base Path field specify the location of the top-level directory where report content items such as report definitions or image files are stored. (This path must be set up as an alias on the Web server.) The Description field is optional.

8. Select the Supports WebDAV option and then click OK to save your settings. The new base path appears in the Base Path(s) field of the server properties page.

9. Click Next. The connection properties page opens.
10. Enter the connection properties for your HTTP server:
   a. Select **DefaultAuth** from the list. When you click **New** to create a new domain, a dialog box appears. Enter the name and description of your domain.
   
   b. Enter the fully qualified name or the IP address of your server.
   
   c. Enter a port number (for example, 8080 for a Web application server).

11. Click **Next**. The New Server Wizard window displays a summary of the settings for the new server and indicates that you have successfully completed the definition of a new server.
12. Click **Finish**. Your new server is displayed under the Server Manager node in the SAS Management Console Navigation Tree.

For more information, see the following resources:

1. The SAS Management Console Help.
2. The SAS online documentation about administering HTTP Servers and WebDAV, available at [http://support.sas.com](http://support.sas.com). Search for Administering HTTP Servers and WebDAV.

---

**Define Publish Locations for the SAS Content Server**

During the SAS Model Manager installation process the **ModelManager**, **sasfolders**, and **sasdav** WebDAV folders are automatically created on the SAS Content Server. You can use the SAS Content Server Administration Console (SCS Admin Console) to create a new publishing location for the WebDAV folder or to control access to an existing WebDAV folder. If you need to define a new WebDAV-enabled HTTP content server after the initial installation of SAS Model Manager, then you must define a publishing location. For more information, see “Define an HTTP or HTTPS Server” on page 43.

**Note:** Although you can add a folder to the **sasfolders** location, the folder that you add is not added to the SAS Metadata Server.

**Tip** The best practice is to add folders to metadata using SAS Management Console.

To define a new publishing location, follow these steps:
1. Access the SAS Content Server Administration console by entering the following URL in your Web browser and substituting the server name and port number of your SAS Content Server: `http://server-name:port/SASContentServer/dircontents.jsp`.

   **Note:** The default port number depends on the application server that is being used. For example, the default port for JBOSS is 8080.

2. Log on to the console as an unrestricted user (for example, SAS Administrator). The SCS Admin Console window appears.

3. Enter a name for the folder in the text box and then click **Add folder** to create a new location for publishing channels.

4. (Optional) To create a subfolder, select the folder that you created in the previous step, enter a name for the subfolder in the text box, and click **Add folder**.

   **Note:** Use the breadcrumb trail above the list to return to a parent folder.

5. To set permissions for a folder, follow these steps:
   
   a. Click the permission icon next to the item that you want to modify. The Permissions page appears.

   b. For each principal that is listed, modify the permissions by changing each permission to **Yes** or **No**.

   c. To add more principals to the page, do one of the following:
      
      - If you know the principal's name, enter it in the field and click **Save changes**.
      - Click **Search for Principals** to search for a name. When you find the principal that you want to add, select the check box that is next to the principal's name and then click **Return**.
After the principal's name appears on the permission page, you can set permissions for the principal.

*Note:* For more information about administering the SAS Content Server, see the *SAS 9.3 Intelligence Platform: Web Application Administration Guide*.

---

### Configuring Channels and Subscribers for SAS Model Manager

#### Overview of Configuring Channels and Subscribers

The Publishing Framework plug-in to SAS Management Console enables you to administer the Publishing Framework.

*Note:* You need to verify that Publishing Framework plug-ins are available in your SAS Management Console navigation tree. If the plug-in is not available, you need to install SAS Foundation Services 1.3 or later so that you can configure your channels and subscribers for SAS Model Manager.

With the Publishing Framework plug-in, you can manage subscribers and channels. For more information, see the Help.

When the Publishing Framework plug-in is available, the SAS Management Console Project Tree should look as follows:

![SAS Management Console - SAS Administrator](image)

The SAS Metadata Server (for example, *Foundation*) that is shown under the Publishing Framework plug-in contains the *Subscribers* folder and the *Channels* folder.
The Publishing Framework plug-in to SAS Management Console provides wizards that enable you to create subscribers. When you create a subscriber with a wizard, the subscriber object that has the specified attributes is stored on the SAS Metadata Server.

For more information about Publishing Framework, see the *SAS 9.3 Publishing Framework: Developer's Guide*.

**Channel to Subscriber Configuration**

There are several ways to configure channels to publish your models to the SAS Model Manager channel subscribers.

Choose one of these options to define the method to use for publishing channels:

1. **None** - specifies to publish all content that is published to the channel directly to the subscribers (through e-mail). The content is not persisted.
2. **Archive** - specifies a path and an optional logical server for the location of the persistent storage. The **Archive File** option is recommended for publishing model packages. Publishing Framework publishes the content as an archive (binary) SPK (SAS package) file to the persistent storage location.
3. **WebDAV** - specifies the WebDAV server location.

**TIP** The best practice is to use the **Archive File** type for channel persistent storage and **e-mail** for subscriber notification.

Before publishing models using SAS Model Manager, you must create channels and subscribers to publish your model updates.

**Creating Channels and Subscribers**

The channel sends the information from the publishers to the subscribers who want it. A subscriber is a person or a program that has a need for information that is published. To receive information from a channel, the user must be defined as a subscriber.

The Publishing Framework plug-in provides wizards that enable you to create subscribers. Information about the subscriber is stored on the SAS Metadata Server.

**Note:** Channel subscribers must be users of the SAS Metadata Server and their e-mail addresses must be specified.

**Create a Channel Folder**

If you expect to create a large number of channels, then consider grouping related channels into channel folders. You can create subfolders within folders, thereby creating a folder hierarchy to which access controls can be applied. For more information, see the SAS Management Console Help.

**Note:** Currently it is not possible to move an existing channel into a folder or from one folder to another. Plan ahead to avoid having to delete and recreate channels.

To create channel folders, follow these steps:

1. From the SAS Management Console navigation tree, expand the **Publishing Framework** node.
2. Select and expand the desired metadata repository node.

3. If you are creating a top-level folder, then select Channels. If you are creating a subfolder, then navigate to and select the desired parent folder.

4. Right-click Channels and then select New Folder.

   The New Channel Folder wizard window appears.

   ![New Channel Folder Window]

   - Enter a name for the new channel folder and then click Next. The new folder is created and the metadata definition information is displayed.
Create a New Channel

To create a new channel, follow these steps:

1. From the SAS Management Console navigation tree, expand the **Publishing Framework** node.
2. Select and expand the desired metadata repository node.
3. If you are creating a channel within a folder, select the **Channels** node and navigate to the desired folder.
4. Right-click **Channels** or the desired channel folder and select **New Channel**. The New Channel wizard opens.

6. Click **Finish**.
5. Specify the name of your channel and click Next.

6. Use the arrow to associate content subscribers with this channel to be notified at publish time. Click Next.
7. Select Archive. The archive page opens.

8. Select File for Archive Type and enter the path of your publish location. Click Next. The information window appears, providing a summary of the input and status of successful completion of the channel creation.

   Note: The Archive storage has two other types, HTTP and FTP, that you can select from the list.

9. Click Finish. The new channel name is displayed under the Channels node of SAS Management Console.

For more information, see the SAS Management Console Help or the SAS 9.3 Publishing Framework: Developer’s Guide.
Create a New Subscriber

SAS Model Manager supports only the content subscriber and the Name/Value pair filter for filtering. You can publish to a channel even when the channel does not have any associated subscribers. SAS Model Manager users can extract contents from a channel if they are not subscribers of the channel. However, only subscribers of a channel can receive notifications. You can also create a subscriber group that contains individual subscribers or other subscriber groups. For more information, see the SAS Management Console Help.

To create a new content subscriber:

1. Expand the Publishing Framework node in the SAS Management Console navigation tree.
2. Select the desired metadata repository node.
3. Select Subscribers ➔ Content Subscribers.
4. Right-click Content Subscribers and select New Content Subscriber. The New Content Subscriber wizard window appears.
5. Specify a name and a description for this subscriber. The name must be unique within its parent folder. The description is optional. Click *Next*.

6. Click *Select* to associate a person with this subscriber.

7. The search filter enables you to search the repository for users whose names either contain or are equal to a string that you specify. Enter the string in the text field, select either *contains* or *equals* from the list, and click *Search*. A list of users whose names meet your search criteria appears in the *Available People* list.
8. If the desired user does not exist in the repository, then click **New User** to define that user. Then, select the desired user from the **Available People** list and click **OK**.

9. Click **Next**.

10. Select the subscriber’s delivery transport and then specify the attributes. Click **Next**.
11. Specify one or more filters to eliminate content that the subscriber does not want to receive. To add a filter, click the tab that corresponds to the type of filter (Name/Value, Entry, or MIME Type). Select Inclusion or Exclusion and then click Add to specify the filter criteria.

12. Click Next.

13. Review the subscriber specifications. Click Back to make any corrections. Click Finish when you are satisfied with your selections.
Modify an Existing Channel or Channels Node Location

Modify the Directory Location for the Channels Node

To change the location of the application channels directory, follow these steps:

1. From SAS Management Console, expand the Application Management node on the Plug-ins tab.
2. Select and expand Configuration Manager ⇒ SAS Application Infrastructure ⇒ Model Manager JavaSvcs 3.1.
3. Right-click Model Manager JavaSvcs 3.1 and select Properties.
4. Click the Advanced tab to modify the application channels directory. Change the property value for App_ChannelDir to a directory that is accessible by the SAS Workspace Server.
5. Click OK.

Modify the Persistent Store Directory Location for a Channel

To modify the location of the persistent store directory path for a channel, follow these steps:

1. From the SAS Management Console navigation tree, expand the Publishing Framework node.
2. Select and expand the desired metadata repository node.
3. If you are modifying a channel within a folder, select the Channels node and navigate to the desired folder.
4. Right-click the name of the channel that you want to modify, and then select Properties.
5. Click the Persistent Store tab, and modify the archive file path and server location.
6. Click OK.

See Also

SAS Management Console Help
Overview of Managing Data Tables, Users, Groups, and Roles in SAS Management Console

SAS Management Console is the primary tool that is available to administer the SAS Metadata Repository. SAS Management Console is a framework that provides a variety of plug-ins that expand the capability of SAS Management Console. Only certain users can view and use plug-ins. A user’s access to plug-ins depends on which roles the user is assigned to and which capabilities are assigned to those roles. SAS Model Manager makes extensive use of the SAS Metadata Repository. Therefore, SAS Management Console is used to perform a number of administrative tasks. Some of those tasks include managing users, groups, roles, and data tables. For information about other administrative tasks such as creating users, groups, roles, and channels, see Chapter 3, “Setting Up SAS Management Console for Use,” on page 15.

For information about SAS Management Console and plug-ins, see “Understanding the State of Your System” in the SAS Intelligence Platform: System Administration Guide. Also, see the SAS Management Console Help.

Modifying a Data Table

SAS Model Manager does not provide a way to modify the structure of a data source table. If a data source table is modified externally (using SAS Management Console, for example), then the existing SAS Model Manager scoring tasks might stop functioning.

For more information, see SAS Management Console Help or the SAS Intelligence Platform: System Administration Guide.
Deleting a Data Table

Overview of Deleting a Data Table

Data tables can be deleted only from the SAS Metadata Repository using SAS Management Console. Data tables cannot be deleted from SAS Model Manager using the Data Sources view. If the data table's metadata is deleted from the SAS Metadata Repository using SAS Management Console or the operating system, SAS Model Manager cannot access the data table to view data or to perform any reporting or scoring tasks. In this case, an error message appears.

*Note:* Only a SAS Administrator or a user with Delete permission can delete data tables using SAS Management Console.

Delete a Data Table in SAS Management Console

To delete a data table in SAS Management Console, follow these steps:

2. On the **Plug-ins** tab, expand the following folders:
   - **Environment Management** ➔ **Data Library Manager** ➔ **Libraries**.
3. Select the library that contains the data table that you want to delete.
4. Right-click the data table name in the right pane, and then select **Delete** from the pop-up menu. The **Delete Table** dialog box is displayed.

5. Click **OK** to delete the data table. The data table is removed from the SAS Metadata Repository library, but it is not physically removed from the operating system.

For more information, see SAS Management Console Help or the *SAS Intelligence Platform: System Administration Guide*. 
Managing Users, Groups, and Roles

You use SAS Management Console to set up users, groups, and roles to define which actions a user can perform when using SAS Model Manager. For information about setting up a user, group, or role, see “Configuring Users, Groups, and Roles” on page 20.

In order to make access distinctions and track user activity, security systems must know who is making each request. The primary purpose of user administration is to provide information that helps systems make this determination. The SAS environment requires one external account ID for each user. The SAS environment then uses its copy of these IDs to establish a unique SAS metadata identity for each connecting user. All of a user's group memberships, role memberships, and permission assignments are ultimately tied to their SAS metadata identity.

To access user administration features in SAS Management Console, select the User Manager node on the Plug-ins tab. Your roles and permissions determine which user administration tasks you can perform.

Note: The User Manager node is the only location from which you can manage identities.

For more information, see the SAS Management Console Help or the SAS Intelligence Platform: System Administration Guide.
activity
See workflow process activity

candidate model
a predictive model that evaluates a model's predictive power as compared with the champion model's predictive power.

champion model
the best predictive model that is chosen from a pool of candidate models in a data mining environment.

channel
a virtual communication path for distributing information. In SAS, a channel is identified with a particular topic. Using the features of the Publishing Framework, authorized users or applications can publish digital content to the channel, and authorized users and applications can subscribe to the channel in order to receive the content.

classification model
a predictive model that has a categorical, ordinal, or binary target.

data set
See SAS data set

data source
a table, view, or file from which you will extract information. Sources can be in any format that SAS can access, on any supported hardware platform. The metadata for a source is typically an input to a job.

DATA step
in a SAS program, a group of statements that begins with a DATA statement and that ends with either a RUN statement, another DATA statement, a PROC statement, or the end of the job. The DATA step enables you to read raw data or other SAS data sets and to create SAS data sets.

DATA step fragment
a block of SAS code that does not begin with a DATA statement. In SAS Model Manager, all SAS Enterprise Miner models use DATA step fragments in their score code.
**identity**  
See metadata identity

**input variable**  
a variable that is used in a data mining process to predict the value of one or more target variables.

**instance**  
See workflow process instance

**library reference**  
See libref

**libref**  
a SAS name that is associated with the location of a SAS library. For example, in the name MYLIB.MYFILE, MYLIB is the libref, and MYFILE is a file in the SAS library.

**metadata**  
descriptive data about data that is stored and managed in a database, in order to facilitate access to captured and archived data for further use.

**metadata identity**  
a metadata object that represents an individual user or a group of users in a SAS metadata environment. Each individual and group that accesses secured resources on a SAS Metadata Server should have a unique metadata identity within that server.

**milestone**  
a collection of tasks that complete a significant event. The significant event can occur either in the process of selecting a champion model, or in the process of monitoring a champion model that is in a production environment.

**model function**  
the type of statistical model, such as classification, prediction, or segmentation.

**model scoring**  
the process of applying a model to new data in order to compute outputs.

**output variable**  
in a data mining process, a variable that is computed from the input variables as a prediction of the value of a target variable.

**package**  
See SAS package file

**package file**  
See SAS package file

**participant**  
See workflow participant

**prediction model**  
a model that predicts the outcome of an interval target.

**process**  
See workflow process
process definition
See workflow process definition

project
a collection of models, SAS programs, data tables, scoring tasks, life cycle data, and reporting documents.

Project Tree
a hierarchical structure made up of folders and nodes that are related to a single folder or node one level above it and to zero, one, or more folders or nodes one level below it.

publication channel
an information repository that has been established using the SAS Publishing Framework and that can be used to publish information to users and applications.

publish
to deliver electronic information, such as files and system-generated events, to one or more destinations. These destinations can include e-mail addresses, message queues, publication channels and subscribers, WebDAV-compliant servers, and archive locations.

Publishing Framework
a component of SAS Integration Technologies that enables both users and applications to publish SAS files (including data sets, catalogs, and database views), other digital content, and system-generated events to a variety of destinations. The Publishing Framework also provides tools that enable both users and applications to receive and process published information.

SAS Content Server
a server that stores digital content (such as documents, reports, and images) that is created and used by SAS client applications. To interact with the server, clients use WebDAV-based protocols for access, versioning, collaboration, security, and searching.

SAS data set
a file whose contents are in one of the native SAS file formats. There are two types of SAS data sets: SAS data files and SAS data views. SAS data files contain data values in addition to descriptor information that is associated with the data. SAS data views contain only the descriptor information plus other information that is required for retrieving data values from other SAS data sets or from files whose contents are in other software vendors' file formats.

SAS Metadata Repository
a container for metadata that is managed by the SAS Metadata Server.

SAS Metadata Server
a multi-user server that enables users to read metadata from or write metadata to one or more SAS Metadata Repositories.

SAS package file
a container for data that has been generated or collected for delivery to consumers by the SAS Publishing Framework. Packages can contain SAS files, binary files, HTML files, URLs, text files, viewer files, and metadata.
SAS publication channel
   See publication channel

SAS variable
   a column in a SAS data set or in a SAS data view. The data values for each variable describe a single characteristic for all observations (rows).

scoring
   See model scoring

scoring function
   a user-defined function that is created by the SAS Scoring Accelerator from a scoring model and that is deployed inside the database.

scoring task
   a process that executes a model's score code.

segmentation model
   a model that identifies and forms segments, or clusters, of individual observations that are associated with an attribute of interest.

source
   See data source

SPK
   See SAS package file

subscriber
   a recipient of information that is published to a SAS publication channel.

variable
   See SAS variable

version folder
   a folder in the Project Tree that typically represents a time phase and that contains models, scoring tasks, life cycle data, reports, documents, resources, and model performance output.

WebDAV server
   an HTTP server that supports the collaborative authoring of documents that are located on the server. The server supports the locking of documents, so that multiple authors cannot make changes to a document at the same time. It also associates metadata with documents in order to facilitate searching. The SAS business intelligence applications use this type of server primarily as a report repository. Common WebDAV servers include the Apache HTTP Server (with its WebDAV modules enabled), Xythos Software's WebFile Server, and Microsoft Corporation's Internet Information Server (IIS).

workflow
   a model for a sequence of activities, declared as work of a person, a group, an organization, or one or more mechanisms. Workflows are generally designed to enable a work process that can be documented and learned.

workflow participant
   a user, group, or role that is assigned to an activity of a workflow instance.
**workflow process**

a set of one or more linked activities which collectively realize a business objective or policy goal, normally within the context of an organizational structure defining functional roles and relationships.

**workflow process activity**

a task or step in a workflow process.

**workflow process definition**

an activated process template that is available in the SAS Workflow Engine for use. Process definitions contain the set of activities, participants, policies, statuses, and operands that comprise a business task.

**workflow process instance**

a running process in the SAS Workflow Engine or a working version of a process definition.
Index

A
administration overview 1
Archive File type channels 42

C
channel folders, creating 50
channels
See publication channels
configuration
connection profiles 16
publication channels 41
SAS Metadata Repository 5
SAS Model Manager 4
SAS Model Manager channels and subscribers 49
SAS Workflow 12
users, groups, and roles 20
configuring
dashboard reports 8
Java Web Start 10
number of observations 11
connection profiles
connecting to 19
creating 16

D
dashboard reports 8
data tables
See tables
defining HTTP or HTTPS servers 43
defining publish locations for SAS
Content Server 47
deleting tables 62

G
groups
configuring 20
creating new groups 25
managing 61, 63

H
HTTP or HTTPS servers
defining 43

I
instructions.html file 4

J
Java Web Start 10

L
libraries
creating in SAS Management Console 32
organizing 15
limit number of observations 11
Log on as a batch job 4

M
MMchannel 42
model SPK files, registering 5

P
plug-ins, access to 61
preparing SAS Model Manager for use 3
public directories
creating on SAS Content Server 5
publication channels
Archive File type 42
configuring 41
creating channel folders 50
creating new channels 52
creating new subscribers 55
**MMChannel** 42
Publishing Framework plug-ins 19, 49

**R**
registration
of model SPK files 5
of tables 36
roles
configuring 20
creating new roles 27
managing 61, 63

**S**
SAS Content Server
accessing the Administration Console 5
creating a public directory 5
defining publish locations 47
SAS Enterprise Miner
using SAS Model Manager with 5
SAS Management Console 61
access to plug-ins 61
creating libraries in 32
managing tables, users, groups, and roles 61
Publishing Framework plug-ins 19, 49
registering tables 36
setting up for SAS Model Manager use 15
User Manager plug-in 63
SAS Metadata Repository
configuring 5
connection profiles 16
storing table metadata 15
SAS package files
See SPK files
SAS Publishing Framework 41
See also Publishing Framework plug-ins
scoring result set
limit number of observations 11
SPK files
registering a model SPK file 5
subscribers to channels, creating 55

**T**
tables
creating with SAS code 35
deleting 62
managing 61
modifying 61
registering 36
verifying accessibility 39

**U**
User Manager plug-in 63
users
configuring 20
creating new users 23
managing 61, 63

**V**
verification
SAS Model Manager 4
table accessibility 39

**W**
WebDAV folders
creating as publishing locations 47
Windows
Log on as a batch job 4
workflow
configuring 12